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What is NINJAM 
 

What is NINJAM? 

NINJAM is an open source (GPL) software to allow people to make real music together via the Internet. 

Every participant can hear every other participant. Each user can also tweak their personal mix to his or 

her liking. NINJAM is cross-platform, with clients available for Mac OS X, Linux, and Windows. 

REAPER (our digital audio workstation software for Windows and OS X) also includes NINJAM support 

(ReaNINJAM plug-in). 

 

NINJAM uses compressed audio which allows it to work with any instrument or combination of 

instruments. You can sing, play a real piano, play a real saxophone, play a real guitar with whatever 

effects and guitar amplifier you want, anything. If your computer can record it, then you can jam with it 

(as opposed to MIDI-only systems that automatically preclude any kind of natural audio collaboration). 

 

Since the inherent latency of the Internet prevents true realtime synchronization of the jam, and playing 

with latency is weird (and often uncomfortable), NINJAM provides a solution by making latency (and the 

weirdness) much longer. 

 

Latency in NINJAM is measured in measures, and that's what makes it interesting. 

 

The NINJAM client records and streams synchronized intervals of music between participants. Just as the 

interval finishes recording, it begins playing on everyone else's client. So when you play through an 

interval, you're playing along with the previous interval of everybody else, and they're playing along with 

your previous interval. If this sounds pretty bizarre, it sort of is, until you get used to it, then it becomes 

pretty natural. In many ways, it can be more forgiving than a normal jam, because mistakes propagate 

differently. Part tool, part toy, NINJAM is designed with an emphasis on musical experimentation and 

expression. 

 

How does NINJAM work? 

NINJAM uses OGG Vorbis audio compression to compress audio, then streams it to a NINJAM server, 

which can then stream it to the other people in your jam. This architecture requires a server with adequate 

bandwidth, but has no firewall or NAT issues. OGG Vorbis is utilized for its great low bitrate 

characteristics and performance. Each user receives a copy of other users audio streams, allowing for each 

user to adjust the mix to their liking, as well as remix later. This uses more bandwidth than having a 

server encode a single stream, but has numerous benefits (including lower server CPU use and the client 

having the full multichannel data for later use). NINJAM can also save all of the original uncompressed 

source material, for doing full quality remixes after the jam. 

 

*While MIDI has many wonderful uses, it also has substantial limitations when working with real 

instruments. 

*Limitations of note: sound hardware latency (>5ms), perceptual CODEC latency (>20ms), plus typical 

and theoretical network latency (>40ms). 

 

 

WEBSITE: 

http://www.cockos.com/ninjam 

 

NINJAM Source Code 

github.com/justinfrankel/ninjam 

 

 

 

 

 

http://www.cockos.com/ninjam
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Intro 
 

 

*This guide is for Windows (all versions) 

 

Software used in the guide: 

Reaper v4.31 + v6.75 

Ninjam v0.06 (official client) 

Asio4all driver v2.15 

Windows 7 x64 SP1 

Poulin VST for guitar 

Cubase 5.1 (DAW) 

 

Hardware Requirements: 

A laptop or desktop computer with Windows installed. 

A fast internet connection like ADSL or fiber. 

 

For best audio quality you’ll need an ASIO supported audio card (USB, firewire, PCI or PCI-E) 

 

 

 

 

 

 

 

Useful websites 

http://wiki.cockos.com/wiki/index.php/NINJAM_Documentation 

https://www.cockos.com/reaper/userguide.php 

http://www.cockos.com/ninjam/ 

http://www.reaper.fm/ 

http://ninbot.com/ 
http://jamtaba-music-web-site.appspot.com/  (Ninjam compatible app with looper & video features) 

http://www.asio4all.org 

http://bedroomproducersblog.com/free-vst-plugins/ 

http://www.kvraudio.com/ 

 
Some websites record the online jams & save the individual tracks & the remixed copies in their servers, 

usually in mp3 format. 

http://ninbot.com/ 

http://www.archive.org/details/ninjam 

 

http://wiki.cockos.com/wiki/index.php/NINJAM_Documentation
http://ninbot.com/
http://jamtaba-music-web-site.appspot.com/
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Using Reaper & ReaNinjam plugin 
 

REAPER is a Digital Audio Workstation for Windows, macOS, and Linux that also provides native 

NINJAM support via the "ReaNINJAM" plug-in, and allows you to use VST/VSTis/ReWire/MIDI 

hardware/etc with NINJAM. REAPER also can import NINJAM sessions directly for remixing/editing.  

Using Reaper instead of the official Ninjam client, gives you more versatility, sound control and tons of 

features. You can download it from: www.reaper.fm 

 

 

 
 

 

 

Select Audio Device 

Because of lag in computer audio, it is recommended the use of an ASIO audio card, the type of PCI, 

firewire or USB audio interface. In case you don’t have that type of audio card, you can use your PC’s 

onboard audio card, however with poor sound quality. In that case it’s recommended you download and 

install the free Asio4All driver from: www.asio4all.org 

 

After installation, open Reaper, go to Options>Preferences>Device tab and select your audio system. It 

always must be ASIO. In the field ASIO Driver select your Audio card or select «ASIO4ALL v2» if you 

are using your PC’s onboard audio card and have installed Asio4all drivers. 

 

file:///C:/Users/Motorwinder/Desktop/www.reaper.fm


 5 

 
 

 

 

Load Ninjam into Reaper 

Press the FX button in «master» channel & a new window will appear. 

In the left pane select «Cockos» and in the right pane: 

VST: ReaNINJAM (Cockos) 
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Two windows will pop-up. You can close the FX: Master Track and leave the window: «ReaNinjam» 
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ReaNINJAM window functions 

1. By checking this box you transmit your sound to ReaNinjam. 

2. Level meter. Make sure it stays about -12db and never hits red. Lower your signal from your audio 

card or from the track in Reaper and NOT by the ReaNINJAM window. 

3. Metronome mute button. Every server transmits a metronome click relatively to its bpm setting. 

4. The area where the other players of a server appear, as a list of channels. 

5. This area is for server messages and chat between players. 

6. In this black area the large digit number shows the bpi cycle of the server. 

7. Status bar with useful info like: connection status, bpm, bpi, server name. 

8. Name of your channel. You can type anything here, your name, what you play, etc.  

 

 
 

 

Open Ninjam preferences from file menu and check «Save multitrack recordings for remixing later» if 

you want to save the jam into hard drive. If you check «save uncompressed .WAV» the jam will be saved 

in large WAV audio files & you’ll need a lot of free hard disk space. In «Save session files in» field, 

choose a folder location for saving the jams. 
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Next step is to create a track in Reaper and assign to it a microphone, a guitar or bass with a vst plugin, a 

midi keyboard, electronic drums or anything else you like. 

Go to Track>Insert new track 

 

To name your track double click the blank field and type what you want (guitar in my case). 

 

 
 

If you want to load a VST plugin for electric guitar, bass or vst effect for vocals, then press the FX button 

in the track (same procedure applies for midi instruments). 

 

In the left pane select VST and in the right pane, select your VST plugin. The dedicated interface of the 

VST plugin will pop-up, so that you can select or modify your sound. In my example i selected a VST 

plugin for electric guitar. 
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If Reaper don’t detect a VST you have installed, then add its folder location in Reaper.  

Open Preferences and click VST menu in left pane. 

 

 
 

 

It is very important to select the input of your instrument. To select INPUT left click in the area shown in 

photo & the input menu will appear. If you connected your guitar cable to left or right input in your audio 

card, make sure you select it in your «track’s input». In my setup it’s the Right input, labeled «Analog B» 

as shown in photo. Same method is required for other instruments, microphones and midi. 

 

 
 

 

Next step is to activate (arm) record button as shown. Play your instrument and watch for the signal 

indicators to light up. 

Save your setup project in Reaper by clicking Ctrl+S 
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To connect to a server click Connect button in ReaNINJAM window. Type your preferred username & 

select a server from the list. If you want to connect to a private server, you must check the option box 

«Connect with password» & type your username & password that Admin gave you. 

The server list has some info about every server’s address, bpm, bpi, user capacity and the usernames of 

people or bots currently connected online. Check the box: « I agree to the above license terms», click 

«Αccept» and your are connected! 
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Useful tips when connecting to a server 

-If your channel inside ReaNINJAM has signal activity, then your setup is ready. 

-Before entering a server, uncheck your channel’s «xmit» checkbox, so that you don’t disturb the other 

players, in case you need to setup your sound first, tune your instrument, browse vst presets etc.  

-Use headphones if you use microphone for vocals or in front of instruments, amplifiers etc. and switch-

off your pc speakers, or else echo and other noise will occur. 

-If you want to mute or solo a player, press the corresponding buttons as shown in photo. Uncheck a 

player’s Receive checkbox (Recv) if you want to disable his transmission to you. 

-Adjust each player’s volume by moving the individual sliders. 

-If your channel’s level meter hits red, then you must lower your signal from your audio card or from the 

track in Reaper and NOT from the slider inside ReaNINJAM window. Make sure it stays about -12db. 

- Tips for having the best Ninjam experience: https://forum.cockos.com/showthread.php?t=273122 

 

Chat commands 

!vote bpm 130   «starts a vote for tempo change, e.g. 130 bpm» 

!vote bpi 16   «starts a vote for bpi change, e.g. 16 bpi» 

/clear   «clears all text in chat window» 

/msg Nickmanak@73.112.55.XX text message «sends a private message to another player» 

 

Websites that list servers 

http://autosong.ninjam.com/server-list.php 

http://ninjam.dyndns.org/ 

http://ninbot.com/ 

http://ninjamer.com/ 

 

 

 
 

 

https://forum.cockos.com/showthread.php?t=273122


 12 

Using official Ninjam client 
 

Download and install official Ninjam client:  

https://www.cockos.com/ninjam/downloads/ninjam_winclient_006.zip 

 

 

 
 

 

Click Options > Audio configuration 

Select ASIO in “input/output system” field. 

Select your ASIO Driver in the field below. 

 

 

 

https://www.cockos.com/ninjam/downloads/ninjam_winclient_006.zip
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Click Options > Preferences and check the options you want for saving your jam into hard drive. 

 

 

 

 

 

Click File > Connect 

Check option: “Connect anonymously” 

Type a username 

Type the name of the server manually (there is no auto server list here, like Reaper). 

Same functions apply here, as described in previous pages for ReaNinjam in Reaper. 

Ninjam client has built-in effects that can be used by checking the option “Effects processor” and clicking 

“config”. 
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Using MIDI 
 

First connect your midi device (e.g. usb midi keyboard), install its driver (if required) and then start 

Reaper. Open Preferences in Reaper and select MIDI Devices from left pane. Right-click the label of 

your midi keyboard and select Enable input. Do the same in the window below, for midi output. 

 

 
 

 

 

 

Create a track in Reaper, assign a VST FX (piano, synth etc) and select Midi input & channel for that 

track. Last step is to activate monitor button and Record arm button for that track. 

 

 

 
 

 

 



 15 

Using 2 Ninjam Channels 
 

Create 2 tracks in Reaper. Press I/O button in Master track. 

 

 
 

 

In “Track Channels” select 4 

 

 
 

 

Press I/O button on 2nd track (channel 2) and select “Parent channels” 3-4 
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In ReaNINJAM window click Add Local Channel 

In the new channel select Stereo 3/4 as shown in photo. 

 

Two separate channels in Ninjam are useful when you want to play different sounds in each channel.  

You can load a drum machine in track 1 and play the bass in track 2. 

You can load an audio backing track and sing vocals in the 2nd track. 

For server bandwidth reasons it’s recommended that you don’t use more than 2 Ninjam channels.  

Concerning Reaper, you can create more than 2 tracks if you want and route their audio signal to any of 

the 2 ReaNinjam channels. 

 

 

 
 

 

 

 



 17 

Save jam in Hard Drive & remix yourself 
 

 

If you want to save a jam in your hard drive and remix it later, select this option in ReaNinjam or Ninjam 

client preferences and set a folder for saving. 

 

 

 
 

 

After a jam, browse to that folder and see the various folders created. Every time you connect and play to 

a server, a folder is created with the date and time you were connected. If you uncheck a player’s receive 

checkbox when playing to a server, his audio part won’t be saved in the folder.  

  

 
 

Open a jam folder & see the smaller folders and a file named CLIPSORT. 

 

 
 

Open Reaper and with mouse DRAG the clipsort.log file inside Reaper & an import window pops. 
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If you click Yes a process window will appear & Reaper will merge all the individual audio files of the 

jam, into large WAV files. Depending on your computer, the number of players & the duration of the 

jam, this process may take some time and use large disk space. 

If you click No Reaper will create tracks for each player but the audio of each track will be in many small 

audio parts. You need enough RAM to use this option. 
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How to setup your own server 
 

The main requirement for running the server is outbound bandwidth. For example, a 4 person jam needs 

approximately 768kbps of outbound (and only 240kbps inbound) bandwidth, and a 8 person jam requires 

approximately 3mbps of outbound (and 600kbps inbound) bandwidth. 

 

-Download server software from ninjam website:  https://www.cockos.com/ninjam/ 

It’s in zip archive and it doesn’t need installation. 

-Extract the contents of the zip file into an empty folder. Rename this folder (e.g. My_Ninjam_Server) 

without blank spaces. 

-Move that folder to C:\Program files or anywhere else you like. 

-Open the folder and then open the file example.cfg with a text editor like notepad. 

-Copy all contents to a blank notepad and save in .txt format under a name you like (e.g. server.txt). 

-Close example.cfg and make some adjustments to server.txt file. 

-Any line that starts with # its disabled, so it’s a way to disable a command or write comments. 

-After all tweaks SAVE & rename the extension of your file from server.txt to server.cfg 

 

NINJAM server setup guide (official) 

To set up a NINJAM server, first find a host that has an abundance of outbound bandwidth. Or if you 

want to use NINJAM on a LAN with all of the hosts local, that is an option as well. The server can 

currently run on Windows, OS X, Linux, and FreeBSD. To download the server for your platform, see the 

download page. 

To install the server, extract the archive (or copy the contents of the .dmg if on a mac) to a directory, then 

edit the example configuration file to suit your needs. Here is a list of the configuration items and what 

they mean: 

 

Port n - port for server to listen on. The default is 2049. 

 

ServerLicense filename.txt - forces users to view and agree to the license provided to connect. This is 

useful if you want to run a public server and make people who contribute to a jam license their parts 

under a Creative Commons or similar license (or whatever license you choose) 

 

MaxUsers n - maximum number of users allowed. 

 

MaxChannels n n - set the maximum channels per user for normal (first parameter) and anonymous 

(second parameter) users. 

 

SetLog filename - logs to file named "filename". If not specified, logs to standard output. 

 

SessionArchive path interval - if set, archives all recordings to the path provided, and creates a new 

subdirectory every "interval" minutes. If interval is 0, the interval is 30 seconds. 

 

DefaultTopic topic - default server topic. 

 

DefaultBPM bpm - default server BPM (range 20 to 400) 

 

DefaultBPI bpi - default server BPI (range 2 to 1024) 

 

AnonymousUsers yes|no|multi - allow users to log in anonymously (if no, only users with a valid 

login/password will be allowed). If multi is specified, then multiple anonymous users from the same IP 

with the same nickname can log in. 

 

AnonymousUsersCanChat yes|no - allow anonymous users to send chat messages (if no, they can play, 

but can't contribute to the chat) 

https://www.cockos.com/ninjam/
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AnonymousMaskIP yes|no - if yes, mask the last number in anonymous users' addresses. 

AllowHiddenUsers yes|no - if no, users without any channels will appear in the user list. otherwise, they 

will not. 

 

User username password [permissions] - This adds an authorized user to the user list. If permissions are 

specified, the default permissions are overridden. Specify * for all access, or include any combination of 

the following to enable them: 

C - allow this user to chat with other users 

T - allow this user to set the server topic 

B - allow this user to adjust BPM / BPI of server 

K - allow this user to kick other people 

R - allow this user to log in even when server is full 

M - allow this user to log in multiple times 

 

ACL mask allow|deny|reserve - This adds an entry to the Access Control List (ACL). The configuration 

file can have any number of these, and the first match is used. mask is in the format of x.x.x.x/y, i.e. 

192.168.0.0/16 or 66.88.120.240/28. allow specifies to allow connections, deny specifies to not, and 

reserve specifies to always allow (even if there are too many users connected). 

 

SetKeepAlive n - sets connection keepalive time to "n" seconds. Recommended value is 3. 

 

SetPID filename - writes process PID to "filename". Only valid on non-Windows systems. 

 

Once you've set the configuration the way you think you will like it, you can run the server: 

On OS X/Linux/FreeBSD (OS X will require you to open a terminal and go to the proper directory):  

./ninjamsrv configfilename.cfg 

On Windows (after opening a command line, and going to the proper directory): 

ninjamsrv configfilename.cfg 

If you need ot change the configuration once the server is running, you can restart it by hitting R (on 

Windows), or by using the command "killall -HUP ninjamsrv" (on Linux/FreeBSD/OS X). 

 

 

Some necessary server.cfg tweaks for the beginner  (my comments are in red color). 

Port 2049    choose between 2049–2052. Only one port is allowed 

# limit connections of normal users to 10 

MaxUsers 6       defines how many users can connect to your server 

 ServerLicense cclicense.txt   Pop-up window with license, when a user connects. You can edit the 

license text which is inside the server folder 

#anonymoususers yes or no, or multi (to allow multiple users of the same name from the same IP)  

AnonymousUsers yes  If you type yes, any user can connect to your server without password 

AnonymousUsersCanChat yes  If you type yes, any anonymous user can chat to your server 

AnonymousMaskIP yes  with yes, server shows just the nn.nn.nn.x instead of full IP 

 ACL 10.0.0.0/8 deny if you can’t connect to your server from the same pc, disable this line with # 

#user/password/permissions sets 

User name password * set username & password for the server Admin 

User name password CBTKRM  If you make a private server, here you can set each member’s 

username, password & privileges. CBTKRM are: allow Chat, Bpm/bpi, Topic changing, Kicking, 

Reserved slot, Multiple logins. You can use any letter of CBTKRM or combinations (e.g. CB, CTK, 

KRM). 

DefaultTopic write a text after the command to set a topic in your server 

DefaultBPM 110   sets the tempo of the server in bpm 

DefaultBPI 16  Sets the Beats Per Interval of the server. Type from 2-64 
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# voting system: 

SetVotingThreshold 50  sets threshold to 50%. 50 means 50% of total users needed for a voting to pass. 

Can be 1-100%, or >100 to disable. 

SetVotingVoteTimeout 180  sets timeout in seconds before votes are reset. 
_____________________________________________________________________________________ 

Open port in your router 

You must open the port you defined in server.cfg (2049, 2050, 2051 or 2052) 

To learn how to open your router's port, visit this website: 

http://portforward.com/ 

 

Starting your server 

Open a cmd (command prompt) window and change directory with CD command. 

If the server folder (e.g. My_Ninjam_Server) is in C:\Program Files then type in cmd: 

 

CD C:\Program Files\My_Ninjam_Server 

 

If you are inside the server folder, type DIR and check the contents. 

If ok type:  ninjamserver.exe Server.cfg 

Your server is up and running as you can see in the cmd window.*You must leave the cmd window 

open 
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Admin commands in Ninjam server 

Inside cmd window press the following letters in keyboard to execute a command: 

[S] list with connected users 

[R] reload server.cfg if you made changes 

[K] kicks a user from the server 

[Q] terminates the server 

/bpi 16 

/bpm 120 

/msg user message 

/kick user 

 

How can other players connect to my own server 

First find your IP adress. Visit this or similar websites to find what is your IP. 

http://www.whatismyip.com/ 

 

Take your IP number for e.g.  85.211.52.15  and add your server.cfg port :2049 at the end. So you will 

have: 85.211.52.15:2049 

 

Any player that wants to connect to your server must type 85.211.52.15:2049 in the field: 

"Connect to host" in Ninjam standalone client or ReaNinjam in Reaper. 

 

If you set usernames and passwords in your server.cfg then if someone wants to connect, must check the 

option box «Connect with password» & type his username & password. 

 

 

 

I want to connect to my server from the same PC that the server is running 

If you want to connect as ADMIN or member (in a private server), check the option box «Connect with 

password» & type your username & password you set in your server.cfg 

 

If you can’t connect to your server as described above, first step is to find your local IP address. 

Open a cmd and type 

ipconfig /all 

 

Write down the IP ADDRESS or IPv4 ADDRESS number as listed & add :2049 at the end. 

In "Connect to host" field you will type that number x.x.x.x:2049 to connect and play. 
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Using other DAW for Ninjam 
 

You can use other DAW for Ninjam like: Cubase, Ableton, Sonar, FL Studio, synth workstations etc. The 

following guide is about Cubase 5 but with slight modifications can be used on other DAW as well. 

(Reaper skin in this tutorial is from version 3) 

 

This method requires both Reaper and Cubase to be running, so it will be demanding in cpu and ram. 

 

Reaper has it’s own Asio driver called ReaRoute ASIO driver which functions as a virtual audio driver 

and provides communication between Reaper and other audio software. 

 

When you install Reaper for the 1st time this option is unselected by default. In that case you reinstall 

Reaper and select the option “ReaRoute ASIO driver”. 
 
 
 

 
 

 

 

IMPORTANT 

ReaRoute driver won’t work if you use different bit versions of the 2 DAW. 

Meaning that Reaper 64bit won’t work with Cubase 32bit version & vice versa. Both Cubase & Reaper 

must be the same type. 

 

 

ALWAYS start Reaper first, so that ReaRoute driver can load in the background & the other audio 

software can detect it. 

 

 

Next start Cubase and go to menu Devices and select Devices Setup. 

Select VST Audio System in left pane and for ASIO driver select ReaRoute ASIO as shown in next 

photo. 
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In the left pane select ReaRoute ASIO (under VST Audio System) and locate the 2 ports that send audio 

from Cubase to Reaper. Their status must show active. 
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Go to Reaper and create a new track by pressing CTRL+T 

 

Left click for track input and select Stereo ReaRoute 1 / ReaRoute 2. This means that you will receive 

stereo audio signal from Cubase into Reaper. You can select other input depending on the situation (e.g. 

mono audio or midi). 

 

 

 
 

 

 

 

 

 

 

 

 

 

On your Reaper track enable monitor & arm record as shown in photo. 

 

Next, load and setup ReaNinjam in Reaper’s Master track, as described in previous pages of the guide.  
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The photo below shows Cubase, were you created a stereo track, loaded an audio file and started 

playback. The audio is transmitted inside Reaper through ReaRoute and finally to ReaNinjam, as you can 

see in the following photos. 
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Next tutorial shows how to create more tracks in Cubase that sends audio in separate Reaper tracks.  

In Cubase press F4 and then press Add Bus for adding another stereo Output. 

 

 

 

In Cubase select a track and in the left settings (photo below) change the numeration: 

First track:   No Bus & Stereo Out 

Second track: No Bus & Stereo Out 2 

Third track:    No Bus & Stereo Out 3  etc. 

 

 
 

If you have midi tracks in Cubase or using VST Plugins then you will modify only the Stereo Output. 

You must do this from the mixer window (F3) and not from the main window (photo below). 
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In Reaper create a 2nd track and choose for input: ReaRoute 3 / ReaRoute 4 so that it matches the 3/4 

output you created in Cubase. 

 

 

 

 
 

 

Enable in both Reaper tracks monitor & record arm buttons. Start playing in Cubase and check the audio 

that is transmitted inside Reaper tracks and ReaNinjam. 

 

 

 

 
 

 

 

 

You can create 2 channels in ReaNinjam (read previous pages) and route the 2 tracks of Cubase into these 

channels via the 2 Reaper tracks, so that they are independent. 
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Session Mode in Ninjam 
 

Ok so we had it for a while but it's not used much, maybe because many are not sure how to or what it 

does so this hopefully shine some light on Session Mode. 

First I will explain what it is and how to use, then explain the diagrams below. 

 

Session Mode is like a Blank Rewritable CD which lasts as long as the users want. So imagine a friend 

had a bunch of rewritable cdr's and when you heard a beep you started playing at 120bpm and he 

recorded all of you on a separate CDR's, then at the end he played all the CDR's back to you all 

simultaneously. But say the Drummer messaged up at say 1 minute into recording, now imagine if the 

friend said "hey it's rewritable I can start recording you again from 1 minute", so the drummer played and 

corrected his mistake. Now Imagine REAPER was that Friend and the CDR was in fact a NINJAM 

Channel set to Session Mode. 

But instead of a friend playing and controlling the CDR's you can just click PLAY on the REAPER 

window at any starting point of what's been recorded and hear everyone else's CDR's at the same time, 

this is how Session Mode Works. 

So to use Session Mode you first need too enable it on the ReaNINJAM Window shown below, 

remember this though, once enabled to use Normal NINJAM again you must switch it back to Normal or 

in a Normal NINJAM others won't hear you. See A1 in Diagram 1. 

 

 
 

Now that your set to Session Mode you need to know how to use it. 

Below in the Diagram 2 the first things you need to know is (J) in the diagram 2, this is the PLAY button 

in REAPER, when in Session Mode to start all's audio (CDR's) you must click play. Soon as you click 

play NINJAM Session Mode is Recording any Audio you make in REAPER. 

 

What is the Measure Bar? 

You need to understand the Measure Bar at the top of diagram 2 which looks like a Ruler. On diagram 2 

it shows 1.1.00, 5.1.00, 9.1.00 and so on, these are Bars, a bar consist of 4 Beats or 1/1. 1.1.00 too 5.1.00 

would be in NINJAM a bpi 16. 
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How to Setup a Looped Range on the Measure Bar 

You see here in diagram 2 that at (A) we have 2 small triangle shapes, this depicts the Looped Area which 

is Enabled using (G) in diagram 2. 

You can set this looped area by clicking and holding the mouse button on the ruler at the start then drag 

and hold the mouse to the end of your desired looped area, or you can Enter the Start of the Loop in (D) 

left then the end of the Loop in (D) right. 

(E) shows how many Bars you have Looped. 

The Loop Range is important as you can see in (B) that there is a bunch of recordings instead of one like 

the rest, this is where it has looped 3 times and I replayed the part each loop. Then I clicked on 1 part 

from the 3 loops that I liked best and this part is then played. 

Sometimes when playing a warm up or few repeats are needed to play it right. 

So once you have set the looped area you want, then Enable it using (G) in diagram 2. 

 

The Transport Control Panel 

The Transport Control Panel are basically the play, stop, forward, rewind and record buttons.  

You have the (H) buttons which move (C) the starting point for play or record to the Start of the Measure 

Ruler or End of your records. 

(J) is the PLAY button, if you don't click this in Session Mode you will not hear anything, but if you just 

leave it playing without looping an area then it could still be playing up to 50 minutes but everyone else 

stopped playing at say 5 minutes so you will only be hearing silence. So in this case just click (H) on the 

left to go back to the start. 

(K) is the RECORD button, for others to hear you in session mode you only need to press the (J) PLAY 

button and make some noise then if you say "BOO" at 5.1 then everyone will hear you say boo at 5.1 

when they play that measure. However if you then play past 5.1 and make no noise then the "BOO" will 

be erased, so anything you want to keep you need to use the (K) RECORD button. 

(G) as mentioned previously is to Enable the Looped Area of (A) 

 

Further along to the right on the Transport Panel you will see (F) which is the BPM, now in session mode 

you need to Mute the NINJAM Metronome then Click OPTIONS on the REAPER window and select 

Metronome Enable. Now you want to set the BPM to the BPM you and your friends in the Server agree 

too. If your not sure just ask "What's Session BPM?". 
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So for a quick short reference of what needs setting for Session Mode. 

Session Mode (A1-Diagram 1) 

REAPER BPM (F) 

PLAY BUTTON (J) 

 

Also other settings which will help, it will be much easier having the Metronome Count you in 8 beeps 

before you start recording, this can be set by going to Options (A2) in Diagram 3, then too Metronome 

and pre-roll setings... (B2) in Diagram 3. 

  

 



 32 

Another window will appear called Metronome and pre-roll settings, in this you will see Count-in before 

Recording (A3) in Diagram 4. Tick this, there is also an option above, this won't be needed but if you 

have a metronome play for 8 beats every time you click play then check if this is ticked. 

 

 

 
 

 

 

*Session mode guide by:  AndyMc 

 

 

 

More about session mode in the following link: 

http://forum.cockos.com/showthread.php?t=9227&highlight=session+mode 
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